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Indicates a hint
Provides information on how to avoid operating errors or information emphasizing
important details

Indicates the solution to a problem
Provides troubleshooting information or answers to frequently asked questions

Indicates a list item

Indicates a prerequisite
A condition that has to be fulfilled before starting a particular operation

Indicates a single-step operation

Indicates steps within operating sequences

Used for references and for table or figure titles

Used to identify a link to related information as well as previous or next steps

Used to identify window titles, menu items, function names, buttons, and keys, for
example, the Save button

Used to emphasize particularly important sections of the text

Used for on-screen output of the system including code-related elements or
commands

Identifies inputs you need to provide

Used for the navigation to a certain submenu entry

Identifies variables or parameters, for example, within a string

CAUTION
Used with the safety alert symbol, indicates a hazardous situation which, if not
avoided, could result in minor or moderate injury or material damage.
CAUTION consists of the following elements:
◾ Information about the nature of a hazardous situation

◾ Consequences of not avoiding a hazardous situation

◾ Methods of avoiding a hazardous situation

Italic

Bold

Blue
Courier

Courier
Menu > Menu Item

<variable>

Legend
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WARNING
Indicates a hazardous situation which, if not avoided, could result in death or
serious injury.
WARNING consists of the following elements:
◾ Information about the nature of a hazardous situation

◾ Consequences of not avoiding a hazardous situation

◾ Methods of avoiding a hazardous situation

Legend
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Introduction

In order to operate the MR system accurately and safely, the
operating personnel must have the necessary expertise as well as
knowledge of the complete operator manual. The operator manual
must be read carefully prior to using the MR system.

Layout of the operator manual
Your complete operator manual is split up into several volumes to
improve readability. Each of these individual operator manuals covers
a specific topic:

◾ Hardware components (system, coils, etc.)
◾ Software (measurement, evaluation, etc.)
Another element of the complete operator manual is the information
provided for the system owner of the MR system.
The extent of the respective operator manual depends on the system
configuration used and may vary.

 All components of the complete operator manual may include
safety information that needs to be adhered to.

The operator manuals for hardware and software address the
authorized user. Basic knowledge in operating PCs and software is a
prerequisite.

The current operator manual
This manual may include descriptions covering standard as well as
optional hardware and software. Contact your Siemens Sales
Organization with respect to the hardware and software available for
your system. The description of an option does not infer a legal
requirement to provide it.

1

1.1

1.2

Introduction 1
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The graphics, figures, and medical images used in this operator
manual are examples only. The actual display and design of these
may be slightly different on your system.
Male and female patients are referred to as “the patient” for the sake
of simplicity.

Intended use
Your MAGNETOM MR system is indicated for use as a magnetic
resonance diagnostic device (MRDD) that produces transverse,
sagittal, coronal and oblique cross sectional images, spectroscopic
images and/or spectra, and that displays the internal structure and/or
function of the head, body, or extremities. Other physical parameters
derived from the images and/or spectra may also be produced.
Depending on the region of interest, contrast agents1 may be used.
These images and/or spectra and the physical parameters derived
from the images and/or spectra when interpreted by a trained
physician yield information that may assist in diagnosis.
1 The drugs mentioned herein shall be used consistent with the
approved labeling and/or indications for use of the drug. The treating
physician bears the sole responsibility for the diagnosis and treatment
of patients, including drugs and doses prescribed in connection with
such use.
Your MAGNETOM MR system may also be used for imaging during
interventional procedures when performed with MR compatible
devices such as in-room displays and MR Safe biopsy needles.


The MAGNETOM MR system is not a device with measuring
function as defined in the Medical Device Directive (MDD).
Quantitative measured values obtained are for informational
purposes and cannot be used as the only basis for diagnosis.

 For the USA only: Federal law restricts this device to sale,
distribution and use by or on the order of a physician.

1.3

1 Introduction
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 Your MR system is a medical device for human use only!

Authorized operating personnel
The MAGNETOM MR system must be operated according to the
intended use and only by qualified persons with the necessary
knowledge in accordance with country-specific regulations, e.g.
physicians, trained radiological technicians or technologists,
subsequent to the necessary user training.
This user training must include basics in MR technology as well as
safe handling of MR systems. The user must be familiar with potential
hazard and safety guidelines the same way the user is familiar with
emergency and rescue scenarios. In addition, the user has to have
read and understood the contents of the operator manual.
Please contact Siemens Service for more information on available
training options and suggested duration and frequency of such
training.

Definitions of different persons

Term used Explanation

User/Operator/
Operating per-
sonnel

Person who operates the system or software,
takes care of the patient or reads images
Typically physicians, trained radiological techni-
cians, or technologists

System owner Person who is responsible for the MR environ-
ment. This includes legal requirements, emer-
gency plans, employee information and qualifica-
tions, as well as maintenance/repair.

1.4

1.4.1

Introduction 1
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Term used Explanation

MR worker Person who works within the controlled access
area or MR environment
User/Operator as well as further personnel (for
example, cleaning staff, facility manager, service
personnel)

Siemens Serv-
ice/service per-
sonnel

Group of specially trained persons who are
authorized by Siemens to perform certain mainte-
nance activities
References to “Siemens Service” include service
personnel authorized by Siemens.

1 Introduction

16 Body | Operator Manual
Print No. MR-05013G.630.14.04.24



Preparation

2.1 Preparing and positioning the patient 18

2

Preparation 2

syngo MR E11 17
Print No. MR-05013G.630.14.04.24



Preparing and positioning the patient

Reducing motion artifacts
1 Instruct the patient to hold completely still during the entire

examination.

2 Instruct the patient to take shallow and gentle breaths during free-
breathing measurements.

Respiratory cushion
When performing measurements with respiratory triggering:
◆ Attach the respiratory cushion to the patient using the respiratory

belt.

Breathhold commands
When performing breathhold measurements:
◆ Ensure that the patient wears the headset so that the breathhold

commands can be understood despite the gradient knocking.

Preparing the contrast agent injection
Prior to moving the patient table into the magnet, you route the tube
for the infusion.
1 Insert an intravenous port into the forearm vein of the patient.

2 Connect the port to the extension tube.

 The tube should be long enough so that it can be accessed from
the outside when the patient is in the magnet bore.

3 Connect the tube to the contrast agent injector.

Preparing dark lumen colonography
Preparation includes full cleansing of the bowels the day before the
examination followed by one night of fasting.
1 Inform the patient about the entire examination.

2 Explain the filling of the intestines with water.

2.1

2.1.1

2.1.2

2.1.3

2 Preparation
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3 Practice holding one’s breath with the patient.

4 Position the patient on one side on the patient table.

5 Position the inflow for filling the intestines with water.

6 Move the patient into the prone or supine position.

7 Prepare the contrast agent injection.

Preparing ECG-triggered examinations
Positioning the electrodes and PERU
Electrodes: Positioning of the electrodes varies according to the
position of the heart. An example is provided in the figure below.

 Use only disposable ECG electrodes as released by Siemens.
( Page 20 Procurement addresses)

PERU: The ECG sensor in the PERU ensures transfer of the ECG signal.
Typically, the PERU is aligned in the direction of the foot end of the
patient table even though the patient may be positioned feet first in
the direction of the magnet bore.
◆ Position the PERU in the appropriate support or add absorbent

material between the ECG cables, PERU and skin. The distance
between PERU and patient should be at least 2 cm.

Positioning the ECG electrodes (left) and the PERU (right).

2.1.4

Preparation 2
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
The transmitter unit of the PERU includes three LEDs for signaling
the battery status and one LED as fault indicator (e.g. insufficient
skin contact of the ECG electrodes).
Battery status and electrode fault are also indicated on the Dot
display above the magnet bore and the Physiological Display
dialog window.

 If the red LED Electrode fault on the PERU flashes, the ECG
electrodes are not attached correctly. Check to ensure that the
electrodes are not falling off.

Attaching ECG electrodes
The electrodes must be positioned and attached with care to ensure a
sufficient and consistent ECG signal.
1 Discuss the breathholds and respective commands with the

patient.

2 Ensure satisfactory contact between the electrodes and the
patient's skin.

3 Thoroughly clean the patient's skin with a dry cloth or NUPREP ECG
& EEG Abrasive Skin Prepping Gel . ( Page 20 Procurement
addresses)

4 If the patient is hirsute, shave the location where you want to
attach the electrodes.

5 Dry the skin carefully.

6 Check the signal at the Dot display above the magnet bore.

7 If the signal received is not satisfactory and consistent, vary the
location of the electrodes. Use new electrodes every single time.

8 If one of the leads does not provide a sufficient signal, change to a
single ECG lead in the Physiological Display dialog window.

Procurement addresses
Disposable ECG electrodes may be ordered from:

2 Preparation

20 Body | Operator Manual
Print No. MR-05013G.630.14.04.24



Siemens Commercial goods (Catalog Med & More), CONMED 2700
Cleartrace

◾ Item no. 07437598 (600 pieces)
or from:
CONMED CORPORATION, 310 Broad Street, Utica, New York 13501,
USA
Cleaning gel: NUPREP ECG & EEG Abrasive Skin Prepping Gel
Weaver and Company, 565 Nucla Way, Unit B, Aurora, Colorado
80011, USA

Preparation 2
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General information
Radiological requirements on the one hand, and anatomical or
physiological requirements on the other, present certain challenges
in the area of body imaging.
The organs of the abdomen are affected by a number of motions that
make it difficult to obtain images free of artifacts.
◾ Respiratory motion
◾ Peristalsis
◾ Pulsation of different arteries, especially the aorta

Image with (left) and without respiratory artifacts (right).

Sequences
Fast or ultra-fast sequences are used for body imaging.
◾ Single-shot sequences (e.g. TurboFLASH, HASTE)
◾ Multi-shot sequences for 2D and 3D measurements (e.g. TSE, GRE)
◾ VIBE for 3D measurements

Measurement techniques
Techniques for reducing respiratory artifacts include measurements
during one or several respiratory breathholds as well as
measurements with triggering during normal breathing.

3.1

3.1.1

3.1.2

3 Measurement

24 Body | Operator Manual
Print No. MR-05013G.630.14.04.24



◾ Single/multi-breathhold techniques (without 2D PACE)
( Page 40 Performing multi-breathhold examinations)

◾ Measurement with navigator triggering during normal breathing
( Page 43 Performing examinations with navigator triggering)

◾ Measurement with respiratory triggering during normal breathing
( Page 58 Performing examinations with respiratory triggering)

iPAT: Application hints
To avoid aliasing artifacts, iPAT protocols can be used.

 Ensure that the FoV is sufficiently large in the iPAT mode
“mSENSE” or use phase oversampling.

 Use a sagittal localizer to ensure that all transverse slices have a
sufficiently large FoV.

 Use spacer pads to prevent aliasing artifacts.

 Multi-contrast FLASH sequences can be used only in the iPAT
mode “GRAPPA”.

Reduced motion sensitivity
For small patient movements, motion artifacts are reduced
significantly by enabling the Reduce Motion Sens. checkbox on the
Sequence Part 1 parameter card of the TSE sequence.

3.1.3

3.1.4

Measurement 3
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Applications:
◾ T2-weighted measurements of head, spine, pelvis, and hip
◾ T2-weighted abdominal applications based on TSE with PACE free

breathing

 The technique is less effective for application setups with higher
Turbo factors. For this reason, breathhold measurements of the
lungs or abdomen are not recommended.

 For the TSE sequence, the BLADE technique may also be used to
reduce motion sensitivity. Detailed information about BLADE is
available in the Application Brochure Pulse Sequences.

Single excitation
For abdominal measurements, a motion-insensitive single-excitation
TSE DIXON sequence is provided. Measurements can be performed
using breathhold and respiratory-triggering techniques.

3 Measurement
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 WARNING

When using the DIXON method, water and fat swaps might
occur!
Incorrect diagnosis
◆ Diagnosis should be confirmed by a second contrast and/or a

different orientation.

 In order to reduce motion artifacts, enable Fast Dixon in the
Contrast Common parameter card.

Radial trajectory
Imaging methods using radial trajectories are more robust to motion,
compared to cartesian sampling. A motion-insensitive VIBE sequence
with trajectory acquisition is available with StarVIBE. The sequence
supports free-breathing measurements.

 In order to reduce motion artifacts, select Radial from the
Trajectory dropdown menu in the Resolution Common
parameter card.

Fat suppression

STIR SPAIR Fat saturation Water
excita-
tion

Dixon

Standard Mode
weak/
strong

Standard Mode
weak/
strong

TSE/SE Yes Yes Yes Yes Yes Yes Yes

HASTE Yes Yes Yes Yes Yes No No

SPACE Yes Yes Yes Yes Yes No No

3.1.5

Measurement 3
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STIR SPAIR Fat saturation Water
excita-
tion

Dixon

FLASH-2D No No No Yes1) Yes2) No No

VIBE No Yes3) No Yes4) No Yes Yes

REVEAL Yes Yes No Yes No Yes No

TFL No No No No No Yes No

TrueFISP No No No Yes No Yes No

Recommended fat/water selective techniques1)2)3)4)

Technique Advantages Disadvantages Applications

STIR ◾ Insensitive to B0 inhomo-
geneities

◾ Timing changes TR, TA
◾ Contrast affected

◾ Detection of metastasis
in the abdominal region

SPAIR ◾ Insensitive to B1 inhomo-
geneities

◾ High performance (quick
mode)

◾ Contrast not affected

◾ Timing changes TR, TA ◾ Abdominal breathhold
applications with TSE,
SPACE, HASTE, and VIBE

◾ Fast T1-weighted breath-
hold applications based
on VIBE (with proper set-
ting of the parameter
“Lines per shot”)

FatSat ◾ High performance (quick
mode)

◾ Contrast not affected

◾ Sensitive to B0 and B1
inhomogeneities

◾ Timing changes TR, TA

◾ T2-weighted abdominal
applications with fat sat-
uration based on TSE,
SPACE, and HASTE

◾ Fast T1-weighted breath-
hold applications with
Quick FatSat based on
FLASH-2D, and VIBE

1) both FatSat and Quick FatSat are available
2) available only with Quick FatSat
3) “Lines per shot” can be selected
4) with Quick FatSat, “Lines per shot” can be selected

3 Measurement
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Technique Advantages Disadvantages Applications

Water excita-
tion

◾ Insensitive to B1 inhomo-
geneities

◾ Contrast not affected

◾ Timing changes TE, TR ◾ Frequently used on low
field systems where
spectral fat suppression
is inapplicable

◾ Transverse TurboFLASH
applications with breath-
hold or PACE free breath-
ing

◾ REVEAL applications in
breathhold technique

Dixon ◾ Insensitive to B0 and B1
inhomogeneities

◾ Multiple contrasts gener-
ated

◾ Contrast not affected

◾ Timing changes TR ◾ Robust fat/water imag-
ing in abdominal applica-
tions

◾ Fat measurements

Comparison of different fat suppression techniques

Optimizing fat suppression
SPAIR fat suppression is available for TSE, SPACE, HASTE, VIBE, and
EPI diffusion sequences.
The main advantages are:
◾ decreased sensitivity to B0 inhomogeneities
◾ increased saturation homogeneity
◾ increased saturation strength
For abdominal imaging with 3T, SPAIR fat saturation can be optimized
for specific regions:
◾ abdomen and pelvis
◾ thorax

Measurement 3
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
The optimized fat suppression regions Abdomen & Pelvis or
Thorax can be selected in the Fat Suppression Optimization
dialog window.
To open the dialog window, click the button on the right side of
the Fat suppr. dropdown menu.
Prerequisite: SPAIR is selected.

For further information, please refer to Operator Manual - Parameters
and Image Text.

REVEAL: diffusion-weighted measurements
Diffusion-weighted imaging shows an increased potential for
differential diagnosis in evaluating body lesions. Accurate lesion
detection is necessary for subsequent therapy planning or follow-up
of lesions.

3.1.6

3 Measurement
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Technique
Principle of DWI: DW MRI is based on the principle that random
motion of molecules during the interval of excitation and signal
measurement reduces the amplitude of the resulting signal. The
application of appropriate pulse sequences (using, for example,
bipolar gradient pulses in one or several directions) allows you to
measure signal cancellation due to diffusion in the given direction.
While normal tissue exhibits gross signal loss, areas with restricted
molecular motion such as densely packed tumor cells show less signal
loss and become bright in diffusion-weighted images.
Auto calibration scan: In general, segmented reference scan
techniques produce artifacts if acquired during different breathholds.
With iPAT including auto calibration scan (ACS), motion artifacts can
be reduced for iPAT values higher than 2. Raw data filtering for the
ACS is not required.
Separate GRE reference scan: For iPAT acceleration factors higher
than 2, the separate GRE reference scan is less sensitive to subject
motion than the separate EPI reference scan.
ADC map: The value of the diffusion of water in tissue is called the
apparent diffusion coefficient (ADC). Based on the diffusion-weighted
images, an ADC map can be calculated, which shows the ADC value
of each voxel in every slice. Restricted water movement in tumors
with high cellularity leads to lower ADC values.
Body diffusion: For body diffusion, trace-weighted single-shot EPI
sequences are used (ep2d_diff, see Application Brochure Pulse
Sequences), which apply diffusion gradients of specific strength and
direction.
The strength of the diffusion gradients is determined by the b-value
[s/mm2]. Typically, an iPAT factor of 2 (GRAPPA) is used to shorten the
echo train and reduce sensitivity to susceptibility. For a good fat
suppression, which is essential for single-shot EPI applications, a fat
saturation pulse is applied or STIR in difficult regions with artifacts
caused by unsaturated fat (e.g., for breast diffusion with REVEAL).
Finally, images are generated which clearly show the diffusion status
within the anatomy.

Measurement 3
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Low b-value imaging

Application using a low b-value (b ≤50 s/mm2) to obtain high lesion
conspicuity with dark vessels. No differentiation between benign and
malignant lesions is possible. Image acquisition can be performed
within one breathhold or with a freely breathing patient to increase
SNR. This technique is beneficial for, e.g. liver examinations as a fast
acquisition add-on to the standard program.

Dark vessel liver imaging with single-shot EPI diffusion sequence with
fat saturation, b-value = 50 s/mm2, in one breathhold (left) compared
to T2-weighted breathhold Turbo spin echo with fat saturation
(right). Improved visibility of lesions as compared to the standard T2-
weighted liver imaging with Turbo spin echo sequence normally
showing bright vessels.
High b-value imaging
Diffusion-weighted imaging with three b-values in the range from
50−1000 s/mm2.

With a b-value above 800 s/mm2, a very good suppression of normal
tissue is obtained and essentially tissue with a high cellularity is
displayed. Image acquisition can be performed within one breathhold
or in free breathing to increase SNR.

3 Measurement
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(1) T2-weighted image
(2) High b-value diffusion-weighted image: The malignant lesion

shows up bright (b-value = 1,000 s/mm2)
(3) ADC map. Due to restricted diffusion, the tumor has a low ADC

Measuring dynamic signal changes
2D and 3D protocols are available for measuring dynamic changes in
signal in different organs and tissues.
Temporal resolution/planning
Fast temporal changes in signal intensity require the highest possible
temporal resolution for the measurement. To realize very short
temporal intervals between measurements, the number of slices
possible as well as their spatial resolution is limited. This is why slice
planning plays an important role in acquiring the organs that are of
interest.

 The multi-slice TrueFISP localizer in the protocol tree is suitable
for displaying the kidneys and the renal artery.

When selecting and adjusting a protocol, it is important to take into
account the temporal resolution for the changes in signal to be
monitored.
2D measurements
During 2D measurements, a low measurement time is selected for
individual slices so that a respiratory shift in the organ seems to be
frozen during image acquisition time and is of negligible importance.

3.1.7

Measurement 3
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The measurement protocols consist of a sequence of slices that are
acquired in the single-shot technique, one after the other. The
orientation of the individual slices may be different. The temporal
resolution is determined by the number of slices. The organ is
motion-corrected during image post-processing.

Example: Measurement of dynamic signal changes with SR-FLASH.

3D measurements
Using the same parameters, 3D measurements show a better SNR
than 2D techniques. However, by necessity their measurement time
is longer.
This is why motions and their effects play a role during the
measurement. It is important to either avoid or, if present, correct
respiratory motion.

 The breathhold technique is a simple and effective method for
reducing spatial shifts in organs and for performing
measurements of high temporal and/or spatial resolution.

Where temporal changes are considered slow in relationship to the
measurement time, the signal course can be documented by using
repeated measurements at suitable intervals.
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Base line
The base line plays an important role when evaluating the time
course of the signal. The base line is determined by the constant
signal value of a tissue prior to observing temporal signal changes.
Several sequence techniques require a number of excitation cycles
until a steady state is reached.


Measurements should be performed that allow for easy definition
of the base line without adversely affecting the monitoring of
fast signal changes. For this reason, separate measurements are
performed including only a few repeats prior to dynamic
changes.

Saturation
Non-selective saturation: When using saturation pulses, the
protocol name includes _sr_. Non-selective saturation is characterized
by generating a uniform magnetic state with vanishing longitudinal
magnetization for all tissues. Once in this state, the sequence-specific
signal is generated as a function of the tissue-specific relaxation
times.
Saturation with an IR pulse: Magnetization prepared by an inversion
pulse with suitable inversion time is often used for displaying
differences in signal. What needs to be considered in this case is the
occurrence of signal fluctuations with long relaxation times. With
signal changes with short T1 relaxation, ambiguous signal
contributions may occur. For this reason, examinations with time-
dynamic imaging are run without using a protocol with inversion
pulse.
Slice-selective saturation: During slice-selective preparation, the
signal is also affected by the blood flowing into the slice. These types
of effects should be avoided for signal analyses that are largely based
on changes in relaxation time.
Selection of saturation pulse: For a comparison of the signal time
curves of different tissues, it is necessary to assess a complete and
homogeneous saturation over the complete selected imaging
volume. In order to achieve this, an optimized saturation pulse should
be used which can be accessed via the Contrast Common parameter
card.
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Aliasing artifacts
Examinations with time-dynamic imaging of the kidneys are usually
performed in the coronal orientation. The phase-encoding direction
runs in this case from left to right. With small fields of view (FoV),
aliasing artifacts may occur caused by the arms aligned along the
sides of the patient. These artifacts are acceptable only if they do not
adversely affect the signal for the kidneys.
Otherwise, the FoV has to be enlarged or phase-oversampling has to
be used.
Evaluation software
Mean Curve may be used for displaying signal-time curves. This
program is suitable for drawing tissue regions and performing base
line corrections.

Time-dynamic imaging with 2D PACE
Usually, the early phase of the measurement should be performed
with high temporal resolution. During this time interval, breathhold
acquisition is performed. The images that follow can be measured,
however, at a larger time interval using navigator triggering.
Both phases of this type of measurement follow one another
automatically. The number of breathhold measurements as well as
the number of slices per respiratory cycle are shown on the Physio
PACE parameter card.
Learning phase: The learning phase is at the beginning of the time-
dynamic image acquisition with combined breathhold measurements
and triggering. The parameters determined during this phase are
used for subsequent measurements with triggering.
Imaging phase: After the learning phase, a respiratory command is
issued and the requested number of images is acquired without
interruption. Following this procedure, the automatic navigator-
triggered measurement begins up to the end of the repetitions set.

 It is important that the position of the diaphragm during the
breathhold closely corresponds to the learned breathing position
for triggering.

3.1.8

3 Measurement

36 Body | Operator Manual
Print No. MR-05013G.630.14.04.24



Advantages: By combining the two methods of fast data acquisition
and triggering, signal evaluation across a longer acquisition time has
been improved. Whenever possible, organs and vessels are acquired
during the same respiratory position and partial volume effects
vertical to the slice plane due to motion are reduced. Currently, these
methods are implemented in the tfl sequence.

Course over time for a time-dynamic image acquisition using
navigator signals: After the learning phase, a deep respiratory intake
period is visible. A temporal high-resolution measurement (red arrow)
is acquired when the trigger conditions are subsequently met. The
navigator signals are not displayed at the end of the breathhold
measurements. However, all following acquisitions are measured
with respiratory triggering.
Urographic display
Using dynamic procedures, it is possible to display renal calyces, the
renal pelvis, and the urinary tract collection system with a 3D
sequence.

Different projection angles of a MIP reconstruction during a dynamic
measurement (inverted display).

You can either compute a maximum intensity projection (MIP) or a
multiplanar reconstruction (MPR).
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Due to their peristaltic movement and anatomical position, it is
frequently impossible to fully display ureters. However, it is also
possible to repeat the measurement several times to acquire
peristaltic waves.
Additionally, it is helpful to provide patients with as much fluids as
possible during urographic examinations.
During a dynamic measurement, the kidneys act to filter out any
substances in the blood. This will result in an increased concentration
of the substance in the kidneys. A corresponding extreme shortening
of relaxation times is then likely.

MR urography at low concentration levels (inverted display). Selective display
of the renal calyces as well as the urinary tract collection system.

It is also possible to perform urography with strongly T2-weighted
sequences. Strong hydrogenation of the patient is especially
advantageous including compression of the lower abdomen, if
required.

MIP reconstruction of a T2-weighted 3D TSE image (inverted display). The
spinal canal is clearly displayed.
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Multi-arterial phase imaging with TWIST-VIBE
For liver multi-arterial phase imaging, the VIBE sequence is extended
by the TWIST technique in combination with CAIPIRINHA and DIXON
with fat/water separation. This allows multi-arterial phase imaging in
a single breathhold with high temporal and spatial resolution.
The advantages are:
◾ high temporal resolution for multiple measurements with TWIST

view sharing
◾ high iPAT factors with CAIPIRINHA
The multi-arterial phase sequence is available in the abdomen dot
library under "multi arterial phase". To run liver dynamics with multi-
arterial phases, replace the entire ABLE block within the Abdomen
Dot Engine with the steps from the abdomen dot library in the Dot
Cockpit.
In the Common Inline parameter card, following parameters can be
defined for TWIST-VIBE:
◾ the size of the Central region A
◾ the Sampling density B used during each pass through the outer

region
◾ the Dynamic recon mode defines the sharing direction of the raw

data (forward sharing, backward sharing, symmetric sharing)
For a detailed description of the TWIST technique, please refer to:
Operator Manual- Vascular.

3.1.9
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Performing multi-breathhold examinations

Single/multi-breathhold techniques
If the patient can hold their breath sufficiently long, the entire
measurement can be completed in a single breathhold. In this way
respiratory artifacts are largely avoided. However, this requires
excellent cooperation on the patient's part, since the patient has to
hold this breath for about 20 s.
Usually, several breathhold intervals are required to fully cover the
anatomy of interest. The number of breathhold intervals depends on
the number of concatenations.
Concatenations: Concatenations subdivide the overall measurement
into partial measurements. The number of concatenations
corresponds to the number of partial measurements.

Planning the examination
Using multi-breathhold protocols, you are able to plan all slices in a
single examination protocol and manually measure the slices of each
breathhold interval.

3.2

3.2.1

3.2.2
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✓ Localizer has been measured

✓ Multi-breathhold protocol has been opened

1 Open the Physio PACE parameter card.

2 Select the Breath-hold option under the respiratory control
parameter.



In order to use automatic voice commands, you have to adapt
the protocol parameters in the Step Properties – Voice
Commands dialog.
For a detailed description of the parameters, please refer to:
Operator Manual - Dot Cockpit.
In this case, the voice commands are only given at the beginning
and the end of the protocol.
If you want to use automatic voice commands at each
measurement, make sure that the Breath-hold option is selected
in the Physio PACE parameter card.

 The duration of the breathhold is available as a tool tip of the
measurement time.

3 Select as many concatenations as necessary to ensure that the
patient is comfortable with the duration of the breathholds.

Measurement 3

syngo MR E11 41
Print No. MR-05013G.630.14.04.24



4 Plan the slices as usual.

Measurement time
The predicted measurement time is computed from the
measurement time of the breathhold interval (= duration of
breathhold) and the number of breathhold intervals per
measurement. The actual measurement time depends also on the
length of the pauses between respiratory intervals and is not known
beforehand.
◆ If necessary, adjust additional parameters relevant to the

measurement time (e.g., TR, Turbo factor, phase resolution).

Minimizing shifts within the measurement
1 Acquire all partial measurements during the end inspiration or end

expiration phase.

2 In the Geometry Common parameter card: Select the interleaved
in breathhold excitation sequence.

Performing the measurement
1 Start the measurement.

 The Wait for user to start option (flagman) in the Protocol step
properties dialog window is not required and should not be
selected for multi-breathhold protocols.

2 Open the Inline Display.

3 Start the first breathhold command as soon as Press Scan in Inline
Display when patient holds breath appears at the bottom left in
the measurement time display.

4 Start the measurement after the patient is holding his breath with
Scan in the Inline Display.

The slices of the first breathhold interval are measured.

During the measurement, the time remaining for the breathhold
interval is counted down in the measurement time display.

3.2.3
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 The number n in the measurement time display Scanning breath
hold… (1 of n) stands for the number of breathhold intervals
measured and not the number of individual measurements.

5 Repeat the last step for each breathhold interval.

 The number of manual starts required for the complete
measurement equals the number of concatenations set.

Performing examinations with navigator
triggering

Navigator triggering
During navigator triggering, a navigator is used for monitoring
respiratory motion. Data acquisition is performed during normal
breathing.
Trigger: The trigger is the reference point in the physiological signal
that releases data acquisition. It synchronizes respiratory motion and
data acquisition.
Learning/imaging phase
The navigator-triggered measurement can be divided into two
phases: the learning phase and the imaging phase.
Learning phase: During the learning phase, the “respiratory pattern”
of the patient is learned to establish the center position of the
acceptance window during the imaging phase. During the first five
respiratory cycles, the navigator acquires the respiratory cycle
without interrupting the measurement. During this period,
respiratory motion is continuously shown in the Inline Display.
Beginning with the second respiratory cycle, a red rectangle shows
the period proposed for data acquisition. The position of the red
rectangles is based on the parameters set and on the evaluation of
preceding respiratory cycles.

3.3

3.3.1
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Width/height of the red rectangle: The width of the red rectangle
corresponds to the acquisition duration. Height and vertical position
of the red rectangles are set so that they fully cover the motion of the
diaphragm during the proposed period. The parameters are set
correctly when the data are acquired toward the end of expiration.

Navigator-triggered respiratory curve. The turquoise rectangle (position of the
navigator) marks the learning phase.

Imaging phase: At the beginning of the imaging phase, the
navigator is repeated at constant time intervals (Scout TR) in order to
acquire the positions of the diaphragm. As soon as the detected
diaphragm position falls within the acceptance window, the
navigator is no longer repeated, and the first block of the actual
imaging sequence is started. The measurement time for one block
corresponds to the acquisition duration.
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Imaging phase of navigator-triggered sequence. After completing one block of
the imaging sequence, the navigator is repeated until the next suitable
respiratory phase is located. No triggers are generated during inspiration
(acceptance window is interrupted).

(1) Acceptance window
(2) Position of diaphragm
(3) Trigger
(4) Scout TR
(5) Acquisition duration
(6) Navigators
(7) Imaging sequence (block)

Respiratory curve: In the imaging phase, the respiratory curve is no
longer displayed during data acquisition. As soon as expiration
begins, the acceptance window is shown as a yellow rectangle. The
height of the acceptance window corresponds to the value of the
Accept Window ± parameter on the Physio PACE parameter card.
The center of the acceptance window is either determined by the
system during the learning phase or is set manually. As soon as the
detected diaphragm position (green curve) falls into the acceptance
window, the first block of the imaging sequence is started.

Planning the examination
Selecting the coil elements
1 To avoid unnecessary noise or artifacts select only relevant coil

elements in the imaging field of view.

3.3.2
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2 Select also a coil element near the navigator.

Measuring the localizers
To enable optimal navigator positioning, the localizers are measured
in free-breathing technique.
◆ Start the measurement of the localizer.

Several transverse and coronal slices through the dome of the liver
are measured.

Adding the navigator

✓ Coronal and transverse localizer slices have been measured

✓ Free-breathing protocol has been opened

1 Open the Physio PACE parameter card.

2 Select the Trigger option under the respiratory control parameter.

The system automatically adds a navigator to the measurement
protocol.


The acquisition duration is available as a tool tip of the
measurement time. To display the tool tip, float the cursor over
the measurement time. In line 2 you will find the number of
required respiratory cycles (5 respiratory cycles for the learning
phase plus X respiratory cycles for the imaging phase).

3 Plan the slices.
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4 Set the imaging parameters (e.g. number of slices per
concatenation, Turbo factor) so that the duration of acquisition
either equals or is reduced by 1/3 of the expected average
respiratory period.

(For a description of reducing the acquisition duration, please refer
to: ( Page 55 Reducing the acquisition duration (optional)).)

 For healthy adults, the respiratory period (interval maximum
inspiration to maximum inspiration) is approx. 4−6 s. However,
this period may be shorter for children1 or the ill.

1 MR scanning has not been established as safe for imaging fetuses
and infants less than two years of age. The responsible physician
must evaluate the benefits of the MR examination compared to
those of other imaging procedures.

Setting the navigator
✓ Navigator is switched on

1 Open the Geometry Navigator parameter card.

2 Set the parameters of the navigator, for example, position, and
orientation.

The navigator is displayed as a turquoise rectangle in the GSP.

Coronal and transverse localizer with navigator.

 A phase navigator is only visible in the GSP if the Manual option
is selected. ( Page 51 Manually positioning the phase
navigator)

3.3.3
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Positioning the navigator
Depending on the type of examination, you can select between two
types of navigator.

◾ Liver dome navigator ( Page 48 Positioning the liver dome
navigator)

◾ Phase navigator ( Page 51 Manually positioning the phase
navigator)

Positioning the liver dome navigator

✓ Navigator is switched on

1 Open the Physio PACE parameter card.

2 From the Scout type list: Select the Liver dome scout.
In the GSP: The navigator is displayed as a turquoise rectangle with
dashed lines.

3 Select the navigator.

1 In the coronal localizers: Select the best image of the dome of the
liver.

2 Shift the navigator to this coronal plane by selecting Protocol >
Shift to image plane from the main menu.

In the GSP: The navigator is displayed as a turquoise rectangle with
continuous lines.

3.3.4

Positioning the navigator on
coronal localizers
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3 Position the navigator centered on the dome of the liver, where
half of the turquoise rectangle is in the liver and the other half is in
the lung.


Please consider whether the localizer was acquired during
inspiration or expiration.

◾ Inspiration: Position the navigator higher (more cranial)
◾ Expiration: Position the navigator lower (more caudal)

1 In the transverse localizers: Select the best image of the dome of
the liver.

2 Position the navigator in the center of the dome of the liver.

3 Double check that the navigator is still centered on the coronal
image.

1 Start the measurement.

2 In the Inline Display: Check whether the navigator is positioned
correctly.

Accurate positioning of the navigator: Display of clearly separated
borders between the lung and liver is seen. The green line will
show the patients breathing motion.

 The green line and the transition between liver/lung do not have
to be congruent.

Positioning the navigator on
transverse localizers

Checking the navigator
position
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Examples: Wrong navigator positions

The navigator is positioned too far towards the lung parenchyma.
Apart from that the detected breathing signal is ok.


In general: The border between the bright signal of the liver and
the dark signal from lung parenchyma has to be within the
turquoise rectangle with dashed lines. In the example, this
requirement is barely met.

◆ Correct the position of the navigator. ( Page 53 Correcting the
position of the liver dome navigator (optional))

The navigator is positioned too far into the liver parenchyma. Apart
from that the detected breathing signal is ok.
◆ Correct the position of the navigator. ( Page 53 Correcting the

position of the liver dome navigator (optional))

Navigator is positioned too
high

Navigator is positioned too low
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The navigator is cutting a vessel (vena cava). The detected breathing
curve is irregular and not feasible.
◆ Correct the position of the navigator. ( Page 53 Correcting the

position of the liver dome navigator (optional))

The navigator is positioned at the border of magnet homogeneity.
The detected signal is jagged and not feasible.
◆ Reposition the patient so that the dome of the liver is within the

area of homogeneity.

 With large patients it may be difficult to position the imaging
volume as well as the navigator in the homogeneity volume of
the scanner. In these cases, consider using the phase navigator.

Manually positioning the phase navigator
Normally, the phase navigator is positioned automatically and is not
visible in the GSP.

 The automatic positioning mode is not available for spectroscopy
single voxel spin-echo measurements (svs_se). In this case, you
have to position the phase navigator manually.

Navigator is cutting a vessel

Navigator is not within the
homogeneous magnetic field
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✓ Phase navigator is switched on

To check and, if necessary, correct the position of the navigator,
proceed as follows.
1 Open the protocol.

2 Open the Physio PACE parameter card.

3 From the Position navigator list: Select the Manual option.

In the GSP: The navigator is displayed as a turquoise rectangle with
dashed lines.

1 Position the phase navigator within the homogeneous liver
parenchyma.

2 Exclude bigger vessels, if possible.


Please consider whether the localizer was acquired during
inspiration or expiration.

◾ Inspiration: Position the navigator higher (more cranial)
◾ Expiration: Position the navigator lower (more caudal)

1 Start the measurement.

2 In the Inline Display: Check whether the navigator is positioned
correctly.

Optimal positioning

Verifying the positioning
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Due to the movement of the liver during the breathing cycle, phase
changes will occur, which are detected and represented in the
breathing curve as displayed in the right image.

Example: Wrong navigator position

The navigator is cutting a vessel (vena portae). The detected
breathing curve is still ok, but may be not feasible, when too much
pulsation is involved.
◆ Correct the position of the navigator.

Correcting the position of the liver dome navigator
(optional)
✓ Liver dome navigator has not been positioned correctly

You may correct the position of the liver dome navigator when, e.g.,
the localizer was generated while the patient was deeply inhaling or
exhaling.

Example: The liver dome navigator is located completely in the liver
(is located too far down). The transition between the dark signal of
the lung and the bright signal of the liver takes place above the
turquoise rectangle.

1 Terminate the measurement.

Navigator is cutting a vessel

3.3.5
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2 Track the navigator asymmetrically to the edge of the diaphragm.

3 Shift the navigator upward (toward the head).

The navigator in the localizer no longer appears symmetrically to the
edge of the diaphragm.

Measuring the respiratory period (optional)
You are able to check whether or not the navigator records the
respiratory signal as required.
◆ On the Physio PACE parameter card: Select the Scout mode

checkbox and start the measurement.

After a complete respiratory interval (at least two end expirations),
the average respiratory period is shown in the Inline Display
(respiratory cycle).

 The Scout mode cannot be selected during the actual
measurement.

Performing the measurement
The breathing behaviour of the patient is strongly affecting the image
quality.
1 Instruct the patient to breathe normally during the entire

measurement (do not stop breathing).

2 Start the measurement.

3 Check the acquisition window during the learning phase. For this
purpose, monitor the width of the red rectangles on the Inline
Display.

3.3.6

3.3.7
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Reducing the acquisition duration (optional)
The acquisition duration is the acquisition time per breathing cycle.
(For a detailed description, please refer to: ( Page 43 Learning/
imaging phase) .) If the width of the red rectangles is larger than 1/2
of the breathing period (horizontal distance from maximum
inspiration to maximum inspiration), the measurement must be
terminated and the acquisition duration reduced. In this manner,
artifacts can be avoided.

 The acquisition duration is available as a tool tip of the
measurement time.

Modifying the acquisition window
On the Physio PACE parameter card you can limit the acquisition
duration with the help of the Acquisition window parameter. Two
modes are to be distinguished: Manual and Automatic.

In the Manual mode, you can enter a fixed value for the acquisition
window.

 3D measurements only support the Manual mode.

3.3.8

Using the Manual mode
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1 From the Select acquisition window list: Select the Manual
mode.

2 Enter the new value for the Acquisition window, for example,
1300 ms.

This value is limiting the maximum acquisition duration.

If you choose the acquisition window significantly shorter than one
third of the individual breathing period, this can lead to unnecessarily
long acquisition times.


To ensure a robust triggering, acquisition duration should be no
more than one third of the individual breathing period of the
patient.
The individual breathing period of the patient is displayed in the
left corner of the Inline Display during a current measurement or
as a tool tip of the Acquisition window parameter (if prior to
that a PACE measurement had been performed).

In the Automatic mode, you can enter the percentage of the
individual breathing period.
1 From the Select acquisition window list: Select the Automatic

mode.

2 Enter the new value for the Acquisition window, for example,
30%.

The concatenations are adapted automatically so that the acquisition
duration is smaller or equal to the specified percentage of the
individual breathing period. Therefore, the sequence adapts
automatically to the individual breathing of the patient.

Modifying further measurement parameters

◆ Increase the number of concatenations.

◆ Reduce the Turbo factor.

Performing a measurement with double triggering
(optional)
Proceed as follows for a combined cardiac-triggered examination.

Using the Automatic mode

TSE sequences

SPACE sequences

3.3.9
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1 On the Physio PACE parameter card: Select the Trigger option
under the respiratory control parameter.

2 Select the desired trigger signal on the Physio Signal 1 parameter
card (e.g. ECG/Trigger).

3 Set the other parameters (acquisition window, trigger delay) as
usual.

Optional measurement parameters
In general you do not have to change the remaining parameters on
the Physio PACE parameter card.

Accept window ± Set the height of the yellow acceptance window in the Inline Dis-
play. There is no display during inspiration.

Position accept window If Automatic has been selected, the system sets the center of the
acceptance window during the learning phase. In the Manual
mode, you can set the value in percent (%) under Accept posi-
tion.

Accept position Shift the center of the acceptance window between the mean end
expiration (0%) and the mean end inspiration (100%).

Scout TR The repetition time of the navigator, when the sequence tracks
the patient's respiratory curve.

Store profile images Store the repiratory curve as an extra series in the patient data-
base.

Trigger pulse For n value, n − 1 respiratory cycles are omitted between neigh-
boring gates. Normally, the parameter is set to a minimum to min-
imize the measurement time.

3.3.10
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Performing examinations with respiratory
triggering

Respiratory triggering
Respiratory triggering is used to keep artifacts caused by respiratory
motion to a minimum. Data acquisition is performed during normal
breathing.
Trigger: The trigger is the reference point in the physiological signal
that releases data acquisition. It synchronizes respiratory motion and
data acquisition.
Respiratory cushion: Respiratory motion is transferred to a
respiratory cushion. The cyclic expansion or contraction of the thorax
is displayed as a respiratory curve in the Physio Display. The
respiratory signal rises during inspiration and falls off during
expiration. It is used to generate the trigger signal as a function of the
respiratory phase selected.

(1) End expiration phase
(2) End inspiration phase

Acquistion window: When using a respiratory cushion, selection of
the acquisition window is of great importance. To minimize motion
artifacts, you typically set the acquisition window during expiration.
As soon as the respiratory signal falls below the threshold set, you
start a partial measurement. The maximum duration of the partial
measurement is set by the length of the acquisition window. When
the respiratory curve falls again below the trigger threshold, you start
the next partial measurement, etc. until all data have been fully
acquired.

3.4

3.4.1
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Setting the acquisition window
✓ Respiratory cushion has been attached to the patient

✓ Localizer has been measured

✓ Free-breathing protocol has been opened

The display of the respiratory signal on the Physio Signal 1
parameter card facilitates correct setting of the acquisition window.

Acquisition window during expiration of the respiratory period.

◆ Select the acquisition window as large as possible to reduce the
measurement time. However, to avoid motion artifacts, limit
yourself to the exhaled, relative motionless area of the respiratory
period.


The duration of the acquisition window is a compromise between
reducing the examination time (large acquisition window) and
the best possible insensitivity to motion artifacts (small
acquisition window).
The duration of the acquisition window depends on the average
respiratory period of the patient. It should include between 1/3
and max. 1/2 of the average respiratory period.

3.4.2
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Performing T1-weighted measurements
Since the average respiratory period is typically between 4–6
seconds, measurement pauses of several seconds occur during which
the system waits for the next respiratory period. While these
measurement pauses facilitate acquisition of T2-weighted images, T1
weighting is difficult to obtain due to the relaxation of the
magnetization.
gre sequence
The gradient echo sequence gre is suitable for this particular
application. To ensure T1 weighting despite respiratory triggering,
the measurements between the two acquisition windows are
continued, however, without data acquisition. The number of
measurements with data acquisition corresponds to the number of
segments on the Physio Signal 1 task card.
To keep the examination time as short as possible, the sequence
automatically selects the largest possible number of segments for a
given acquisition window.
1 If you would like to use saturation pulses, select the Quick

saturation mode.

The measurement time is reduced.

2 If your are using several averages, select the Long term averaging
mode.

Motion artifacts are suppressed.

Performing a dark lumen colonography
With dark lumen colonography, the interior of the intestines is shown
as hypointense as compared to the intestinal wall. Intravenous
contrast agent is added for increasing contrast.

Performing dark lumen colonography
✓ Patient has been positioned ( Page 18 Preparing dark lumen

colonography)

✓ Contrast injector is ready

1 Begin to fill the intestines with water.

3.4.3

3.5

3.5.1
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2 Inject medication for relaxing the intestines.

Control measurement
◆ Check the filling and expansion of the large intestines by using a

TrueFISP or HASTE sequence.

Measuring pre-contrast images
◆ As soon as the intestines are filled and sufficiently expanded,

perform a pre-contrast measurement (3D VIBE sequence) with
respiratory triggering.

Measuring post-contrast images
1 Inject contrast agent.

2 Repeat the 3D VIBE sequence 75 seconds after administering
contrast agent.

Dark lumen image.

 Subsequently, you are able to perform a 3D image evaluation
(MPR, MIP, VRT).

Performing fast T1 mapping
Fast T1 mapping uses a VIBE measurement with variable flip angles.
Corresponding protocols are provided in the Dot Cockpit (Abdomen/
Library/MapIt). To calculate T1, this technique utilizes spoiled gradient
echo (GRE) measurements, each identical except for different flip
angles. syngo MapIt calculates T1 on a pixel-by-pixel basis. To
improve the accuracy of T1 mapping for abdominal imaging, syngo
MapIt is combined with a B1 correction.

3.6
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
The B1 mapping has to be performed prior to the T1 MapIt
measurement. The FoV and slice coverage have to be identical
for both measurements. For this reason, a copy reference is set in
the corresponding Siemens protocol. Prerequisite: The B1 and T1
mapping protocols have to be moved simultaneously into the
queue.

Performing B1 mapping
1 Use the B1 mapping sequence to determine the actual flip angle

for each voxel.

In addition, Prescan Normalize can be performed to reduce the
inhomogeneities due to local coils in the anatomical images.

2 Select Prescan Normalize in the Resolution Filter Image
parameter card.


B1 correction for T1 MapIt cannot be combined with TimTX
TrueShape B1 Shimming (only valid for pTx-Systems).
For further information, please refer to Operator Manual - TimTX
TrueShape.

3.6.1
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Performing T1 mapping
1 For T1 mapping, use the VIBE sequence.

2 Select T1 map in the Inline MapIt parameter card.

T1 mapping allows more than two measurements with individual
flip angle for each measurement separately. This improves the T1
value accuracy in addition to the B1 correction. In addition, T1 can
be determined within several breathhold measurements.

3 Enter the number of measurements to be performed.

4 If the Auto angle calculation is switched On, the flip angles are
chosen automatically, based on the T1 values defined in the
protocol. If you want to freely enter Flip angle values, switch off
Auto angle calculation.

Abdomen Dot Engine
The Abdomen Dot Engine covers MR examinations of the liver, the
biliary and pancreatic system, and the kidneys (morphology). The
reduction of organ motion artifacts is essential for examinations of
the abdominal region. Techniques for reducing respiratory artifacts
include measurements during one or several respiratory breathholds
as well as measurements with navigator triggering during normal
breathing.

3.6.2

3.7
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 The Dot Engine user interfaces shown in this operator manual are
examples only. The actual guidance texts and the design may be
slightly different on your system.

Planning the examination and measuring the
localizer
✓ Patient has been registered

✓ Abdomen Dot Engine has been selected

Adapting the examination to the patient
After registration, the Patient View opens automatically. The default
examination parameters are loaded.

In the Patient View you select a suitable examination strategy,
activate automatic functionalities, and adapt the breathhold
parameters to the patient’s need. In addition, you can decide whether
contrast agent is to be administered or not. The pending protocols of
the measurement queue are updated upon your selection.

◆ From the list: Select a suitable Exam Strategy for the patient.

3.7.1

Selecting the examination
strategy
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Breath-hold Measurements are performed with single/
multi-breathhold techniques. This means
that reduced measurement times are ach-
ieved resulting in reliable and reproducible
image quality.
A mostly automated liver dynamic exami-
nation is included. During the liver dynam-
ics, a single-shot MRCP measurement is
performed.

Resp synchronized Some measurements are performed in free
breathing with navigator triggering
(PACE), with higher resolution as its focus.
A mostly automated liver dynamic exami-
nation is included.

Motion-insensitive For uncooperative/moving patients,
motion-corrected protocols and triggering
are used. Liver dynamics are not included.
Instead, a pre- and a post-contrast meas-
urement is performed.

 In the following example, the strategy Breath-hold is selected.

1 Enter the Breath-hold capability of the patient.

The sequence parameters of the breathhold protocols will be
adapted automatically.

2 If you want to use Automatic breath-hold Commands throughout
the entire examination, activate the checkbox and set the timing
and language for the commands. The language of the breathhold
commands is freely selectable and does not depend on the
language of the system.

 You are also able to set the breathhold commands individually
for each protocol (in the Step properties dialog window).

Setting the breathhold
parameters
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◆ Select Auto Coverage in the Protocol Adaption drop-down menu.

In case of breathhold examinations, select Auto Coverage + BH.

◆ Activate the automatic functionalities, if necessary.

Auto ROI Position of the ROI is suggested by the sys-
tem.

Auto Bolus Detec-
tion

Automatic detection of the contrast bolus
arrival in the region of interest and proper
start of the arterial phase measurement.

◆ Select with Contrast agent from the drop-down menu if contrast
agent is to be used.

Contrast agent protocols will be added in the measurement queue.

You can access the Patient View at any time during the examination.

1 To open the view, click the icon.

2 To confirm the settings and close the view, click the icon.

Changes in the Patient View only apply to pending protocols in the
measurement queue.
1 To change the status of a protocol from measured to pending,

select the measured protocol.

2 Select Rerun from here from the context menu (right-click with
the mouse)

3 Open the Patient View.

or

4 Select Rerun from here with from the context menu (right-click
with the mouse).

The Patient View opens automatically.

5 Enter the requested modifications.

Calculating the FoV
automatically

Activating automatic function-
alities

Using contrast agent

Accessing the Patient View

Modifying parameters of
measured protocols
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Starting the measurement of the localizer
◆ Confirm the patient-specific settings.

The sagittal, coronal and transverse localizers are measured and
displayed.

Subsequently, T2-weighted coronal images are measured and
displayed. Breathhold commands are output before and after the
measurement.

The T2-weighted transverse protocol opens for planning.

Planning transverse measurements
✓ Localizer images and T2-weighted coronal images are displayed

Within this step, you define the FoV and the slice position for all
subsequent transverse measurements.

In the GSP segments, the system makes a proposal for the FoV and
the slice positioning.

1 Check the FoV and the slice position in the GSP segments and
adapt them, if necessary.

2 If necessary, select the Parameter view to adapt additional settings
for the transverse measurements.

3.7.2
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
To increase lesion conspicuity, you may insert a diffusion-
weighted measurement in free breathing mode after the T2-
weighted transverse measurement. For this, select the
corresponding clinical decision point Diffusion in the
measurement queue. Result images show the b values and the
ADC maps.

3 Start the measurement.

After measuring the T2-weighted transverse images, the pre-contrast
protocol opens.

Planning liver dynamics with Care Bolus
✓ T2-weighted transverse images have been measured

✓ Care Bolus workflow has been selected

Setting the dynamic parameters
The liver dynamic measurement consists of four T1-weighted
transverse VIBE-DIXON measurements with breathhold technique.
Within this step, you define the presets for all subsequent dynamic
measurements.

1 Check and adapt the preset delays between the predefined phases,
if necessary.

3.7.3
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2 Activate or deactivate Auto Bolus Detection.

 Even while Auto Bolus Detection is activated, you can manually
start the subsequent arterial phase with Stop&Continue in the
Inline Display.

 If Automatic breath-hold commands is deactivated, the user is
informed by the system when to give the breathhold commands.

Starting the dynamic measurements
1 Start the pre-contrast measurement.

If Automatic breath-hold commands is deactivated, the system
waits for the first breathhold command. For the following
breathhold commands, the system informs the user when to give
the breathhold command.

2 Apply the breathhold command and click this icon.

 If Automatic breath-hold commands is activated, all breathhold
commands are given by the system.

Check the pre-contrast images in the GSP. If the quality is
insufficient, proceed as follows:

3 Select the pre-contrast step and then select Repeat & Open from
the context menu.

Adapt the protocol parameters and start the measurement.

The pre-contrast images are measured. The Care Bolus protocol
opens.
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
Monitoring the dynamic measurements: In the monitoring
window on the left-hand side of the screen, you can follow the
progression of the dynamic measurements.

Positioning the slice and ROI for the Care Bolus

✓ Pre-contrast images have been measured

You use the Care Bolus protocol to monitor the contrast agent inflow
in real time on the Inline Display.

1 Check and adapt the suggested ROI positioning.

or

2 Select an adequate sagittal slice for best vessel visualization.

3 Position the ROI in the sagittal slice by clicking in the GSP (Auto
Bolus Detection On, only).

4 Adjust the slice position for the Care Bolus.
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Starting dynamic contrast agent measurements

✓ Care bolus slice has been positioned

✓ ROI for bolus detection has been positioned

1 Start the Care Bolus measurement.

The main vessel for bolus monitoring is displayed in the Inline
Display at an image rate of approximately 1 image/sec.

2 Begin with the contrast agent injection as soon as images appear in
the Inline Display.

The bolus arrival is monitored in the ROI with Auto Bolus
Detection On and visualized via a corresponding signal curve.

A Stop&Continue icon is available in the icon bar for manual start
or override of the automatic start of arterial phase measurement.

3 With Auto Bolus Detection On, you may check if contrast agent
arrival is detected in time.

4 Override with the Stop&Continue icon if the automatic bolus
detection fails.

Measurement 3

syngo MR E11 71
Print No. MR-05013G.630.14.04.24



– or –

With Auto Bolus Detection Off, manually start the arterial phase
measurement with the Stop&Continue icon upon visual detection
of bolus arrival in the Inline Display.

The consecutive measurement of arterial, venous, and delayed phase
is performed automatically. The delay time settings are taken into
account. Breathhold commands are output before and after each
measurement, if Automatic breath-hold commands is activated.
Otherwise you will be informed when to give voice commands.

The following image data are generated:

◾ Series of original data of all phases
◾ Subtraction series
Performing MRCP and post-contrast measurements

✓ Measurement of the arterial phase is running

You can perform a single-shot T2-weighted coronal measurement for
MRCP between the venous and the delayed phase. You position the
slices for MRCP between the arterial and delayed phase and start the
measurement such that it is finished before the start of the delayed
phase.

1 Position the slices for MRCP.

2 Confirm the settings.
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The MRCP measurement is started automatically after completion of
the venous phase.


As soon as the measurement of the delayed phase is completed,
a T1-weighted coronal VIBE-DIXON measurement with
breathhold complements the preceding transverse
measurements, allowing a detailed analysis of the anatomy in
two planes.

Planning liver dynamics with Test Bolus
Test bolus: Prior to the actual post-contrast measurements, you
inject a small amount of contrast agent at the same injection rate as
for subsequent measurements. A rapid 2D measurement, typically
40−80 images with a temporal resolution of one image per second, is
used to view the passage of the test bolus in the vicinity of the target
vessel.
Planning and measuring the test bolus

✓ Test Bolus workflow has been selected

✓ Pre-contrast images have been measured

1 On the localizer: Position the test bolus slice axially on the aorta on
the level of the diaphragm.

3.7.4
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2 Complete the slice positioning.

The Exam paused dialog window opens.

3 Start the test bolus measurement with Continue and
simultaneously inject the contrast agent.

4 Use the same injection scheme as that used subsequently with the
actual post-contrast measurements.

The test bolus images are displayed.

Determining the transit time
To determine the transit time, you draw a region of interest (ROI) in
an artery (aorta) of the test bolus images. The signal-time curve for
the arterial phase is subsequently computed.

✓ Test bolus images have been measured

1 Scroll through the test bolus series and select a suitable test bolus
image.

2 Draw a ROI by clicking an artery.

The signal-time curve for the arterial phase is computed and
displayed. The system makes a proposal for the data acquisition
window, so that the center of the k-space of the arterial phase is
acquired at the contrast agent arrival in the target organ (liver).

For a description of configuring the bolus timing, please refer to:
( Page 75 Configuring the bolus timing)
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 The quality of the curve depends on the physiology of the
individual patient. If the curve is not satisfactory, simply draw
new ROI.

Setting the timing parameters and performing post-contrast
measurements
1 If necessary, adapt the position of the data acquisition window in

relation to the curve by moving it with the mouse.

2 Check for optimal vessel contrast (the center of the k-space is
acquired at maximum vessel contrast).

3 Check the duration of the automatic breathhold command (if
selected in the Patient View).

4 Complete the planning.

If selected, breathhold commands are output before and after the
measurement. The post-contrast images are displayed.

Configuring the bolus timing
Using the Bolus Timing Dot Add-In you can configure the position of
the data acquisition window relative to the peak of the signal time
curve.

On update of the arterial signal-time curve, the system adapts the
position of the data acquisition window relative to the signal-time
curve.

Setting the acquisition window
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◆ Set the Timing offset to 0 s, to position the data acquisition
window so that the center of the k-space is acquired at the peak of
the arterial phase.

 If you set the Timing offset, for example, to 10 s, then the data
acquisition window is shifted accordingly.

Liver evaluation (LiverLab)
 CAUTION

Evaluated parameter values are only estimated!
Wrong diagnosis
◆ As the given protocol settings are preconfigured but not

standardized always consider that the evaluated parameter
values are only estimated. Therefore you are responsible for
the interpretation of such estimated results.

3.8
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Through advanced signal modeling and parameter fitting algorithms,
both HISTO and multi-echo VIBE Dixon estimate fat signal fraction
and transverse relaxation largely independent of each other, and
hence largely independent of measurement parameters in
appropriate ranges.
Nevertheless, the parameter estimation may be confounded by
additional signal effects and/or inappropriate measurement
parameters, refer to ( Page 82 Settings for multi-echo VIBE Dixon
evaluation) and ( Page 83 Checking the evaluation results) below.
The operator is responsible for the interpretation of results.
The Abdomen Dot Engine Liver Eval CB provides a workflow for
examining the hepatic fat and iron overload as important biomarkers
for various disease processes. For this purpose, two evaluation
methods (HISTO and multi-echo VIBE Dixon) are available.
The workflow corresponds mainly with the Abdomen Dot Engine CB.
After confirming the Patient View and measuring the localizer, the
pre-measurement is performed. The pre-measurement consists of:
◾ automatic liver segmentation
◾ pre-evaluation which provides a first overview of possible overload

in the whole liver
After the subsequent liver dynamics measurements, the evaluation is
performed. The evaluation includes:
◾ spectroscopy (HISTO) and image-based (multi-echo VIBE Dixon)

methods for reproducible evaluation
◾ inline ROI analysis of image-based parameter maps
◾ inline evaluation reports
The HISTO evaluation is an easy to use spectroscopy technique based
on single voxel spectroscopy. The advantages are:
◾ complete data acquired in one breathhold
◾ accurate fat signal fraction evaluation due to integrated T2

correction
◾ significant correlation between the R2 of water and the amount of

iron
The advantages of the image-based multi-echo VIBE Dixon
evaluation are:
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◾ spatially resolved whole liver coverage
◾ simultaneous estimation of fat signal fraction, and R2* as a

measure of iron. Phantom measurements show a reproducibility
better than +/- 1.6 % for fat signal fraction and +/- 6 s-1 for R2*
(based on provided Siemens protocols).

◾ correction for transverse relaxation effects

Planning the examination
✓ Patient is registered

✓ Abdomen Dot Engine Liver Eval CB is selected

Adapting the examination to the patient
After registration, the Patient View opens automatically. The default
examination parameters are loaded.

In the Patient View you select a suitable examination strategy,
activate automatic functionalities, and adapt the breathhold
parameters to the patient’s need. The pending protocols of the
measurement queue are updated upon your selection. In addition to
the Abdomen Dot Engine following decisions for liver evaluation can
be selected.
1 Select Yes in the Liver evaluation dropdown menu.

3.8.1
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2 Select the Evaluation Method: HISTO, multi-echo VIBE Dixon or
Both.

Settings for pre-evaluation
✓ T1-weighted Dixon protocol for evaluation is selected

✓ Contrast Common parameter card is opened

For performing pre-evaluation the following settings are required at
the pre-contrast step:

◾ dual echo Dixon enabled (TE 1 and TE 2 for Opposed phase/In
phase)

◾ only Report enabled under Dixon evaluation
The pre-evaluation determines:

◾ segmented liver volume
◾ ROI or HISTO-voxel position
◾ recommendation for more detailed tissue characterization (fat

deposition, iron deposition, fat and iron deposition, normal,
unclear) based on dual-ratio Dixon discrimination of fat/water and
in-phase/opposed-phase signal ratios

3.8.2
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Checking the pre-evaluation report
After the liver dynamics measurement (ABLE) and the T1-weighted
coronal VIBE-DIXON measurement, the queue is halted at the
decision point Evaluation. Images of the segmented liver are
displayed in the right segment of the GSP. In the Guidance View, the
results of the pre-evaluation are displayed and the selection for Run
liver evaluation is pre-configured.

✓ Liver evaluation has been selected in the Patient View

✓ pre-evaluation has already been performed

1 Check the liver segmentation in the GSP as shown in the guidance
images.

2 Based on the pre-evaluation result, decide whether to run liver
evaluation.

 By clicking Yes, the Evaluation method selected in the Patient
View will be subsequently performed.

Performing the evaluation
The evaluation measurement depends on the selected Evaluation
method in the Patient View. In the following, the multi-echo VIBE
Dixon evaluation will be described.

3.8.3

3.8.4
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✓ Evaluation Method is selected in the Patient View

✓ Run liver evaluation is selected in the Guidance View

 Liver evaluation can also be activated by selecting Yes at the
Evaluation decision point in the queue.

Adapting the ROI and the slice position
A ROI is provided for inline analysis of the parameter maps. The
position of the ROI is preset by the pre-evaluation, and can be
adapted in the GSP subsequently.

1 Check the ROI and the slice position in the GSP.

2 If necessary, adapt the position and the size of the ROI with the
mouse.

 For HISTO evaluation, check and adapt the voxel position, if
necessary.

 Position the ROI/voxel on liver parenchyma, avoid positioning on
large vessels and border areas of the liver.
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Settings for multi-echo VIBE Dixon evaluation
✓ Contrast Common parameter card is opened

The following settings are required at the multi-echo VIBE Dixon
evaluation step:

◾ multi-echo VIBE Dixon enabled (6 echoes)
◾ for Dixon evaluation the options Fat fraction, Water fraction,

T2*, R2* and Report may be selected

 For the evaluation of fat and iron deposition Fat fraction, R2*
and Report are recommended.

 To avoid T1 bias, the flip angle of multi-echo VIBE Dixon
protocols must be low, for example, 4° at TR 10 ms for 1.5 T.
Higher flip angles may lead to over-estimated fat signal fractions.

3.8.5
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
Echo times for multi-echo VIBE Dixon must span the “opposed-
phase” and “in-phase” conditions for water and fat, for example,
2.4 ms … 4.8 ms for 1.5 T, and must reflect typical T2* times, for
example, 5 ms … 25 ms in the liver. The first two echo times
should be near the opposed-phase and in-phase conditions. The
use of Siemens protocols is recommended, which use 6 echoes
between, for example, 2 ms and 10 ms at 1.5 T.


Echo times for HISTO must reflect typical T2 times, for example,
30 ms … 100 ms for liver water signal. The use of Siemens
protocols is recommended, which use 5 echoes between, for
example, 12 ms and 72 ms at 1.5 T.

 For high liver iron, transverse relaxation times shorten
considerably, and measurement parameters may have to be
adapted, in particular by selecting shorter echo times.

Checking the evaluation results
The evaluation results depend on the Evaluation method selected in
the Patient View.


The quality of the parameter estimation can be assessed by the
following criteria: Parameter maps and HISTO spectra should not
display excessive noise. The parameter fit quality metrics should
not deviate substantially from the optimum values: 0% fit error
for multi-echo VIBE Dixon, typically below 5%, and R2 (rsqr) 1.0
for HISTO, typically above 0.95. Results of lesser quality may be
inaccurate.


Confounding signal effects, for example, strong B0
inhomogeneity or susceptibility effects near air/tissue interfaces
or implants, as well as high tissue iron levels, may cause the
parameter estimation to become instable, leading to inaccurate
results and water/fat swaps ( Page 85 Potential complete
swap of fat and water).

3.8.6
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✓ Viewing task card is opened

Multi-echo VIBE Dixon evaluation
Parameter maps are calculated for the selected quantities, for
example R2* maps in units of s-1 and fat signal fraction maps in %.
Maps of signal fit error in % are calculated for quality control. The
segmented liver and the position of the ROI are displayed within the
series: Fat signal fraction, R2*.
A color bar report and a histogram are showing the results of the fat
and iron evaluation by displaying fat signal fraction values and R2*
values, as well as fit error values.

Example: Color bar report (left side) and histogram (right side) for multi-echo
VIBE Dixon

In the color bar report, the following values of fat signal fraction and
R2*, as well as fit error, for the liver segmentation volume and the
ROI are displayed:

◾ mean value (see also corresponding triangles above the color bars)
◾ standard deviation (std)
◾ number of voxels
In the histogram the following values are displayed:

◾ distribution of parameter values for the voxels of the segmentation
volume
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HISTO evaluation

Example: Color bar report (left side) and spectra (right side) for HISTO

The HISTO results include:

◾ The report sheet containing average fat signal fraction within voxel
and R2 of water as text and color bar.

◾ The spectra for shortest echo time (TE=12 ms) and fitted curves for
fat and water signal for quality control.

◾ A table containing fat signal percentage and R2 of water, the
quality of fit and the individual echo values for water and lipid
signals.

Potential complete swap of fat and water

 WARNING

When using the DIXON method, water and fat swaps might
occur!
Incorrect diagnosis
◆ Diagnosis should be confirmed by a second contrast and/or a

different orientation.

If a complete swap of fat and water occurs, unusually high fat signal
percentage values as well as a respective message are displayed in
the corresponding maps.

3.8.7
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In addition, the triangles in the color bar report are not displayed, if
the value is outside the display range.

Example: Complete fat/water swap

1 Check for fat/water swaps.

2 Run HISTO evaluation for comparison.

Repeating the evaluation
You can repeat the evaluation with modified parameter settings or a
different voxel/ROI position.
1 In case of multi-echo VIBE Dixon evaluation, select Rerun from

here from the context menu.

2 In case of HISTO, drag the HISTO protocol from the Program Card
into the queue again or select Append from the context menu.

Multinuclear MR Spectroscopy

General information
Multinuclear Spectroscopy enables measurements and evaluations
for nuclei 3He, 7Li, 13C, 17O (3 T), 19F, 23Na, 31P, and 129Xe. In
addition 31P protocols are available for special applications regarding
muscles (1.5 T and 3 T), head (3 T), heart and liver (1.5 T).

3.8.8

3.9

3.9.1
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 The Multinuclear Spectroscopy option is not available for
MAGNETOM Aera.

In the following, we discuss the characteristics of 31P MRS
examinations for the muscles, heart, and liver. A full description of
the general spectroscopy workflow is located under head
examinations. (Refer to Operator Manual – Neuro.)
31P MRS of the muscle, heart or liver (31P head protocols for 3
Tesla only)
31P MRS acquires the most important energy carriers of the cell such
as ATP, creatine phosphate and inorganic phosphate. Based on the
relative concentrations of these phosphorous metabolites,
information can be collected regarding the energy state of the cell.
The most important examination regions for 31P MRS include the
muscles, the heart, and the liver. Various pathologies of these regions
result in typical abnormalities as compared to healthy patients.
These abnormalities affect:

◾ the absolute concentrations of specific phosphorous metabolites
◾ the pH value
◾ the speed of recovery from stress

 A physiologically triggered measurement via ECG signal is
required for 31P MRS of the heart.

The 31P signal may be enhanced via saturation of the 1H spins
(Nuclear Overhauser Effect, NOE). For this reason, in 31P
measurements 1H saturation pulses are transmitted during the
examination prior to the excitation pulses.

When transmitting 1H decoupling pulses during 31P data acquisition,
spin-spin coupling between the 31P and the 1H nuclei can be
reduced. This results in simplified spectra and increased signal
intensities for certain 31P signals.

1H saturation

1H decoupling
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Performing 31P MRS
Positioning the patient and coil
Siemens provides a Heart/Liver coil for 1.5 T systems. For 3 T systems,
coils from other manufacturers are used.
In the following, the use of the Heart/Liver coil is described. Coils of
other manufacturers are operated in a similar way.
The Heart/Liver coil has dual resonance, i.e., it is resonant for both 1H
and 31P frequencies (63.6 MHz or 25.7 MHz; at 1.5 T) and can be
toggled between the two resonance frequencies. (Coils from other
manufacturers usually have dual resonance as well.)
The Heart/Liver coil is used for both acquiring 31P spectra as well as
anatomical reference images. In addition, the coil is used for
frequency adjustment and for shimming based on the 1H signal.

 During X-nucleus measurements you must remove all 1H coils
(“standard” coils, for example, for the spine) from the patient
table. Only use the specific X-nucleus coils.

1 Position the patient.

2 In case of 31P MRS of the heart: Position the electrodes.
( Page 19 Positioning the electrodes and PERU)

3 Connect the Heart/Liver coil.

4 During registration, select a 31P MRS examination (under Study).

Planning the VOI
31P MRS protocols use either the FID or the CSI FID sequence. The
signal is not localized by the FID sequence. It comes from the entire
sensitive region of the coil. With CSI FID protocols, data acquisition is
performed immediately after localization via slice selection and phase
encoding.

✓ 31P CSI FID protocol has been opened

◆ Due to the absence of a volume selection, select a sufficiently large
FoV. Otherwise, aliasing artifacts might occur.

3.9.2
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 This applies to each spatial direction, because in the CSI FID
sequence each spatial direction is resolved via phase encoding.

Setting the measurement parameters
1 Open the Sequence Nuclei parameter card.

2 Set the requested parameters. For a detailed description of the
parameters, please refer to: Basic Manual - Spectroscopy.

Adjusting the multinuclear frequency
You set the exact resonance frequency for the nucleus determined by
the protocol.
1 Select Options > Adjustments from the main menu.

The Manual Adjustments dialog window is opened.

2 Select the X Frequency subtask card.

Measurement 3
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3 Set the adjustment parameters.

4 Ensure that the bandwidth is large enough to receive the signal.

 To allow for sufficient signal detection, increase the number of
averages for weak signals.

5 Start the frequency adjustment with Go.

6 Set the correct frequency by clicking on the acquired signal peak.

7 Transfer the frequency value to the system with Apply.

3 Measurement
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Adjusting the multinuclear transmitter
Since the signal strength is minimal, transmit adjustment
measurements are not possible during multinuclear measurements.
However, you can define a reference amplitude and apply it as the
new system reference amplitude.
1 Select Options > Adjustments from the main menu.

The Manual Adjustments dialog window is opened.

2 Select the X Transmitter subtask card.

3 Define the new reference amplitude.

4 Transfer the amplitude to the system with Apply.
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You can now begin with the spectroscopy measurement.

Evaluating spectra
For a detailed description of evaluating MRS raw data, please refer to:
Operator Manual- Neuro.
Examples of spectra
We are showing you applications of 31P MRS for the head and
muscle.

Example: Spectrum of the head

Example: Spectrum of the muscle
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Three-dimensional evaluation with syngo 3D
syngo 3D allows you to combine two-dimensional images to obtain a
three-dimensional display of the region of interest. In this three-
dimensional display, you can reconstruct new images, cut out
individual regions and use a range of evaluation functions for special
diagnostic problems.
Multiplanar reconstruction (MPR) is used to place slices in other
orientations through the region of interest.
The maximum intensity projection (MIP) uses the most intensive
gray-scale values of the images for reconstruction. For example, in
contrast medium examinations, blood vessels are those structures
that have the most intensive values.
The Volume Rendering Technique (VRT) is used for differentiating
organs and tissue structures as well as for the colored 3D display of
bones, tissues and organs.
MPR, MIP, and VRT reconstruction is applied, for example, to evaluate
the images of dark lumen colonography examinations.
The following example describes some typical procedures for working
with volume data sets, starting with multiplanar reconstruction
(MPR).

Preparing the data
Loading the image data

✓ All images originate from one study of a patient

✓ All images have the same x/y coordinates and FoV

1 Select the data series or at least three images to be analyzed in the
Patient Browser.

2 Click the 3D MPR icon to start image processing as MPR.

4.1

4.1.1
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
The 3D Series List is displayed.
If this dialog window appears, you have selected more than one
series for processing or the series you transferred is not suitable
for 3D display.
◆ Select the desired series in the 3D Series List or load a suitable

series.

Optimizing the image display

1 Adjust the image orientation in the segments by using the
reference lines and the Orientation subtask card.

2 Activate Rotate Images to tilt and rotate the volume.

An orientation cube is displayed on all images. It indicates the
anatomical orientation of the reconstructed image.

3 To display the relevant image area, zoom and pan the image.

4 Window the images to optimize their contrast and brightness.

Adjusting the image views
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1 Activate Free Mode to allow rotation of the cut lines.

2 Set a view perpendicular to the main axis of the organ in one
segment by rotating the corresponding reference lines.

3 Deactivate Free Mode to freeze the orientation.

4 Click the Ortho Sync icon to set the orthogonal view in the other
segments.

Evaluating the volume data
Reconstructing MIP images
◆ Select a segment and set the MIP display mode with the icon.


When a volume data set containing wideband noise is rendered
using MIP, the resultant MIP image can show chessboard or
stripe-like artifacts when viewed along one of the volume axes.
To reduce these artifacts, select Type > MIP Ultra Quality from
the drop-down menu.

Removing unwanted tissue
With a volume of interest (VOI), you extract a volume of diagnostic
interest to you, thus limiting the volume to be reconstructed to a
partial volume
1 Set the MIP display mode in a segment suitable for VOI definition

(e.g. the axial image).

2 Activate VOI Punch Mode with the icon in the Settings subtask
card.

Aligning to the main axis of the
organ

4.1.2
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The VOI Punch Mode dialog window opens.

VOI drawing is activated automatically.

3 Draw a contour around the relevant image region. Double-click to
finish the VOI definition.

4 Remove the part outside the VOI with the Keep Inside icon.

Now the effective VOI is displayed every time you switch to MIP or
SSD display and activate the Visibility Mask.

Generating parallel ranges
With this option you generate slice images that are parallel to one
another and perpendicular to the active segment.
1 Select the MPR mode and set up a view you require in one of the

segments for positioning the cut lines.

2 Open the Parallel Ranges dialog window with the icon.

3 Enter the number and the thickness of images to be generated.

4 Define the position and orientation of the range with the reference
lines drawn.

5 Start the calculation with Start.
The series of parallel images is displayed in the lower right segment.
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Reconstructing VRT images

1 Select a segment and set VRT display mode with the icon.

2 To optimize the VRT display, open the VRT Gallery (right-click the
VRT icon).

3 Select a suitable VRT parameter set.

The VRT volume image is displayed including the respective tissue
class parameters of the selected parameter set.

 You can change individual VRT parameters on the VRT Definition
subtask card.

4 Set the VRT display mode in the other segments.

5 Window the images to include or exclude anatomy.

1 Activate Free View in the Settings subtask card, if necessary.

The clip plane part of the volume is displayed in the lower right
segment.

Adjusting the VRT display

Using the clip plane tool
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2 Move the mouse cursor with the left mouse button pressed to
push/pull the clip plane through the entire volume.

3 To change the tool that is being used, open the smart select
context menu of the segment.

1 Set VRT thin mode with the icon.

Volume rendering of thin slices out of the 3D data set is performed.
The default slice thickness is 5 mm.

2 To modify the image thickness, right-click the VRT thin icon and
change the thickness in the dialog window.

With this option you generate radial tomographic images, thus
simulating step-by-step rotation around a reference axis.
1 Select the appropriate image for positioning the radial cut lines.

 For example, for a left to right rotation, select the axial image.

2 Open the Radial Ranges dialog window with the icon.

3 Enter the number of images and the angle between the images to
be generated.

4 Define the position and orientation of the range with the reference
lines drawn.

5 Start the calculation with Start.
The series of radial images is displayed in the lower right segment.

Reconstructing VRT thin
images

Generating radial ranges
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Fusing images
The Fusion function allows you to combine the results of different
acquisition techniques or acquisitions performed at different times by
overlaying them.
The following example describes how to align and visualize two
different image data sets from a patient. Evaluation can be performed
by displaying the images side-by-side or overlaid.

Preparing the data
Loading the data to 3D Fusion

✓ Reference and model series cover approximately the same
examination range of the patient

1 Select the first data series to be analyzed in the Patient Browser.

2 Click the 3D MPR icon to start image processing as MPR.

3 Window the images to optimize their contrast and brightness.

1 Select the second data series to be analyzed in the Patient
Browser.

2 Load the data to 3D Fusion with the icon.


The 3D Series List is displayed.
If this dialog window appears, you have selected more than one
series for processing or the series you transferred is not suitable
for 3D display.
◆ Select the desired series in the 3D Series List or load a suitable

series.

4.2

4.2.1

Loading the reference series

Loading the model series
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Aligning the image series
1 Open the Fusion Registration dialog window with the icon in the

Image subtask card.

2 Activate Automatic Registration, if necessary.

3 For an accurate alignment of the loaded series, select the Precise
registration option.

4 Start the registration with Register.

5 Save the registration matrix.

The next time you load two series, the last used matrix is
automatically applied.

6 Merge the reference and the model series into a single data set
with OK.

Evaluating the data
Displaying the images side by side
1 Activate the Side by Side mode with the icon in the Image subtask

card.

The left image area is used to display the reference images and the
right area for the model images.

4.2.2
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2 Use the coupled mouse pointers to compare the data sets
synchronously.

3 Adjust the image orientation by using the reference lines and the
Orientation subtask card.
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Displaying the images overlaid
1 Deactivate the Side by Side mode to return to the Fusion mode.

The two image data sets are displayed in different colors. The
overlaid image data set is displayed in three orthogonal views.

2 To optimize the image display, open the Fusion Definition MPR
dialog window with Fusion > Fusion Definition.

Statistical evaluation with Mean Curve
Statistical evaluation with Mean Curve provides information about
signal changes as a function of time and place. The resulting curve
plots the mean grayscale value against a selectable second variable
(X-axis).

4.3
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The following example describes how to examine the change of the
average grayscale value in a region of interest (ROI) depending on
slice position, trigger time, or image number.

Preparing the data
Loading the image data

✓ MR measurement series or post-processing series (dynamic
analysis, MIP/MPR) are available. All series have the same
orientation and spatial resolution.

1 Select the image data in the Patient Browser.

2 Transfer the data with Applications > Mean Curve to the Mean
Curve task card.

All images are stacked in the 1st segment (evaluation segment).
Sorting is applied within each series and across multiple series
according to initial sort criteria. Image display and evaluation modes
are set automatically:

One series loaded: evaluation mode within series.
The middle image (acc. to within sort criterion) of the
stack is displayed.

Multiple series loaded: evaluation mode across series.
The middle image (acc. to within sort criterion) of the
middle series (acc. to across sort criterion) is displayed.

1 To facilitate contour determination of the evaluation region, drag &
drop suitable images into the 3rd segment.

The image with the same value of the within sort criterion as the
image in the 1st segment is displayed.

 You may load, for example, the subtraction series or the MIP
series. The images must have the same orientation and spatial
resolution as the images in the 1st segment.

2 To facilitate localization of the evaluation region, drag & drop
suitable images into the 4th segment.

4.3.1

Loading images for evaluation

Loading images to support
evaluation (optional)
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 You may load, for example, reference images of the exam or
images showing the relevant region in a different orientation.

3 To move images into a different segment, reload them via drag &
drop.

Optimizing the image display
1 Zoom/pan the images or invert the grayscale values with the

corresponding entries in the Image menu.

2 Window the images to optimize their contrast and brightness.

Determining the sorting for evaluation
By selecting the sort criteria, you establish the scrolling sequence in
the first and third segments and define the X-axis parameter of the
evaluation.
Possible applications of time-related sorting criteria:

◾ Trigger Time: physiologically triggered measurements, e.g. cardiac
series

◾ Echo Time: multi-echo sequences, e.g. multi-echo spin-echo
sequences

◾ Normal Time: dynamic and/or motion studies

 The current sort criterion is displayed in the control area.

1 Open the Scaling dialog window with the icon on the Tools
subtask card.

2 To select the sort criteria in the within series mode, use the X-axis
tab card.

– or –

To select the sort criteria in the across series mode, use the Sort
tab card.
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 In the across series mode, the multiple series are sorted via the
sort criterion of the X-axis (across). The images within each
series are sorted according to the within sort criterion.

Defining the evaluation region
You define the regions for statistical evaluation by drawing ROIs in a
suitable starting image in the 1st or 3rd segment. The ROIs are then
propagated to the other images.
Searching an image for ROI positioning
◆ Display the evaluation region by scrolling in the 1st or 3rd

segment.

Upon scrolling in one segment, the other segment displays the
image with the same value of the within sort criterion.


The across sort criterion is considered when scrolling from series
to series in the 1st segment. The image with the same value of
the within sort criterion is displayed. If no such image is found,
the corresponding series will be skipped.

– or –

Navigate to a suitable image by moving the cut line in the
reference image (4th segment).

The 1st and the 3rd segments display the images with positions that
best match the position of the cut line.

4.3.2
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Drawing ROIs
All tools for ROI definition are available on the Tools subtask card.
◆ Draw up to four ROIs in the starting image in the 1st or 3rd

segment.

The ROIs of the first segment are displayed automatically in the
third segment and vice versa.

(1) ROIs in 1st segment
(2) ROIs in 3rd segment

 If the slice positions in the segments differ, the ROIs in the 3rd
segment are displayed in white with a solid line.

Adapting and propagating ROIs
ROIs are propagated to the images displayed during scrolling or to
images that are not displayed when starting the evaluation. As the
default setting, any change of an ROI in one image is reproduced in
the other images involved (Static ROI mode).
1 To enable individual ROI modification, activate the Dynamic ROI

mode with the icon.

2 Scroll through the images in the 1st or 3rd segment and check if
the ROIs match the anatomy to be evaluated.

3 Correct the size and position of the ROIs, if necessary.

If the Static ROI mode is activated, the (modified) ROIs are
propagated to all other images. Already existing ROIs are
overwritten.
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If the Dynamic ROI mode is activated, the (modified) ROIs are
propagated to the images in the scrolling direction. Already
existing ROIs remain unchanged.

 You can remove a ROI with the Del key. The ROI is deleted in all
images regardless of the active ROI mode.

Performing the evaluation
The following modes can be selected for evaluation:

◾ Absolute evaluation (default setting): The signal intensity in the
ROIs is assigned to the Y-axis.

◾ Relative evaluation: The difference between the signal intensity
and a reference value as well as the ratio of the difference to the
reference value are assigned to the Y-axis.

 Relative evaluation is used, for example, to evaluate the change
of signal intensity in contrast-phase images with respect to the
pre-contrast images.

Switching to relative evaluation
1 Select the Relative evaluation mode with the icon on the Tools

subtask card.

2 Select the reference image (within mode) or the reference series
(across mode) in the dialog window displayed.

3 To exclude the reference image or series from evaluation, uncheck
the corresponding checkbox.

Starting evaluation
1 Click the icon on the Tools subtask card.

The resulting diagram shows a curve for each ROI in the color and
line style of the corresponding ROIs. A table is generated for each
diagram.

4.3.3
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2 To display the intensity of the signal for a defined X-value, move
the vertical measurement line.

 If the vertical line is not visible, it is superimposed directly onto
the Y-axis.

3 To smooth the curve, click the icon on the Tools subtask card.

4 Edit the commentary line with a double-click, if necessary.


The results will be rejected if you add or delete images,
manipulate ROIs, or change the sort criterion. Subsequent
recalculation can be performed automatically if Tools > Auto
Recalculation is selected. If you have loaded a large number of
series, however, you should deselect this option to save time.

Optimizing the result display by scaling

Manual scaling helps you to adjust the graduation of the axes more
accurately to the region of interest.
1 Open the Scaling dialog window with the icon on the Tools

subtask card.

2 Set the boundaries of the X and Y-axes in the respective tab cards.

Scaling the axes
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 If the Relative mode is activated for evaluation, the tab cards Y-
axis (diff) and Y-axis (norm) are displayed for scaling the Y-axes.

3 Subdivide the Y-axis linearly or logarithmically with the Scale
parameter of the Y-axis tab card.

Automatic Scaling is disabled. The manual scaling that has been set
applies to all subsequent evaluations.

Scaling the measured grayscale values is useful if the grayscale values
are proportional to a physiologically relevant value and the
proportionality factor is known (e.g., flow velocity of the blood).
◆ Set the scaling parameters for grayscale values in the Y-axis tab

card of the Scaling dialog window.


Example: Factor = 2, Offset = 20
All Y-values will be multiplied by 2 and shifted 20 units toward
the positive Y-axis.

Automatic Scaling is disabled. The manual scaling that has been
set applies to all subsequent evaluations.

Documenting the results
Setting the background image for diagrams
1 If necessary, adjust the contrast and brightness in the 1st segment

for an optimally visible curve.

2 To use the current image in the 1st segment as the background,
select the View > Image with Graphics option.

 You can reset a black background using the View > Graphics
only option.

Scaling the grayscale values

4.3.4
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Reporting the results

✓ Evaluation results are displayed in the 2nd segment

The report includes all evaluation results. It is stored in DICOM format
in its own series (the report name is derived from the name of the
current series). The Report Editor in the Patient Browser must be
used for further processing.

1 To create a report, click the icon.

2 To add report data for additional evaluations, click the icon.

 Use this function, for example, when you have drawn and
evaluated new ROIs.

Evaluation of dynamic 3D datasets with
Tissue 4D
syngo Tissue 4D is an application card for visualizing and post-
processing dynamic contrast-enhanced 3D datasets.
The software allows the application of non-linear fitting with
pharmacokinetic models and the creation of parameter maps as
color-coded images. The exchange of contrast agents between blood
and tissue is described by the following parameters:

◾ Ktrans (transfer constant)
◾ Ve (extra-vascular extra-cellular volume fraction)
◾ Kep (reflux constant)
Pharmacokinetic modeling is performed pixel-by-pixel using a 2-
compartment model. Calculation is based on the Tofts model.
The following example describes how to apply pharmacokinetic
modeling to dynamic prostate MR examination data for the
calculation of parameter images.

4.4
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Preparing the data
Loading the data to Tissue 4D

✓ Dynamic series have been acquired with fixed flip angle

✓ Pre-contrast series with variable flip angle (i.e. 2°, 15°) are available
for T1 map calculation

✓ Corresponding morphological images are available
(recommended)

1 Select the study to be evaluated in the Patient Browser.

2 Click the icon to transfer the data to the Tissue 4D task card.

Pre-contrast data is displayed in the 1st segment. Dynamic data is
displayed in the 2nd segment.

MPR images at the positions of the dynamic images are calculated
from loaded morphological data. This icon allows toggling between
the pre-contrast data (T1 maps) and the morphological view in the
1st segment.

Optimizing the image display
1 Use the Auto Cine function to get an overview of the loaded

dynamic image data.

2 Activate this function if you want to exclude a certain point in time
from subsequent evaluations.

3 Zoom and pan the images to display suspicious enhancing regions.

4 Window the images to optimize their contrast and brightness.

Performing motion correction
1 Select the 2nd segment and activate subtraction mode with the

icon.

The first volume (reference volume) is substracted. The results are
displayed as magnitude images in the same segment.

4.4.1

Loading the study
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2 Activate 4D scrolling with the icon.

3 Check for motion artifacts in the subtraction images by scrolling in
time (move cursor left/right) and in slice direction (move cursor up/
down).

4 If necessary, start motion correction with the icon on the 1.
Motion Correction subtask card.

The currently displayed volume of the dynamic data is selected as
reference for registration. Motion is corrected in all other volumes.

Registering pre-contrast and morphological data
The reference for registration of the data is a volume of the dynamic
series at the currently displayed point in time.

1 Open the 2. Registration subtask card and select the -PreContrast
mode, if necessary.

In the 1st segment, the pre-contrast images are overlaid with
dynamic images taking the slice positions into account. The
reference volume is shown as colored images.

2 Use the blending slider to visually evaluate the registration quality
of the pre-contrast data with the selected dynamic volume.

3 If necessary, adjust the registration with the icon.

1 Select the Morphological mode in the 2. Registration subtask
card.

Registering pre-contrast data

Registering morphological data
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Fused MPR (three orthogonal MPRs) renderings of the
morphological and the dynamic data are displayed in segments 1,
2, and 3. The reference volume is shown as colored images.

2 Use the blending slider to visually evaluate the registration quality
of the morphological data with the selected dynamic volume.

3 If necessary, adjust the registration with the icon.

Evaluating the data
Calculating enhancement curves
Curve calculation is performed for up to 4 regions defined by ROIs in
the dynamic images.

1 Open the 3. Curve Calculation subtask card.

2 Select ROI1 in the ROI Selection list to set the color and the label
of the first ROI.

3 Draw the ROI around the lesion in a subtraction image in the 2nd
segment.

4 To define additional ROIs, select the corresponding ROI labels in
the ROI Selection list and draw them in the subtraction image.

4.4.2

Defining ROIs
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 If you want to delete a selected ROI, press the Delete key on the
keyboard.

◆ Click the icon to plot the signal enhancement curves.

The calculation results for all defined ROIs are displayed in the 4th
segment. The curves are shown as relative enhancement curves,
the first volume serves as reference.

Preparing pharmacokinetic modeling

The T1 map masks define the areas to be adjusted for the
pharmacokinetic fit. T1 fitting is restricted to pixels with values above
a certain noise level value.
1 Open the 4. Pre Evaluation subtask card.

The T1 map calculation runs automatically. Once the T1 map has
been calculated, the pre-contrast data is replaced.

2 Change the threshold value for masking out noise in the Noise
Level selection list, if neccessary (default: 20).

3 Select the MR acquisition technique in the MR Protocol selection
list (default: T1 + Dynamic).

 If T1 map is not available, dynamic 3D is chosen and an
estimated value for T1 can be set.

Starting calculation

Calculating T1 maps
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The contrast agent parameters are used for the application of
pharmacokinetic models.
1 Select the contrast agent applied in the Contrast Ag. selection list.

Molarity, Relaxivity and Volume are automatically selected by the
system as a function of the contrast agent entered.

 An application specialist can configure a list of preset contrast
agents and assign contrast agent parameters.

2 Adapt the contrast agent parameters in the respective input fields,
if necessary.

By defining a VOI, you restrict the application of pharmacokinetic
modeling to a subvolume of the dynamic volume data.
1 Activate VOI drawing mode with the icon.

2 Draw an ellipse around the organ or around a subvolume in the
2nd segment enclosing the lesion.

The ellipse is extended to form an ellipsoid in the 3D structure.

3 Scroll through the slices to ensure that the VOI covers the part of
the volume relevant for modeling.

4 Modify the VOI, if necessary.

Applying pharmacokinetic modeling
Pharmacokinetic modeling can be applied for the mean curves or
voxelwise for the selected ROI/VOI.

1 Open the 5. Evaluation subtask card and select an ROI in the
Selector list (e.g. ROI1).

Setting contrast agent
parameters

Defining the fitting volume

Fitting mean ROI curves
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2 Select the pharmacokinetic model to be applied in the Model
selection list.

 Currently, the two-compartment Tofts model is provided.

3 Select the Model AIF function which provides the applicable
information about the concentration of the contrast enhancing
media in the blood plasma.

Fast: high temporal resolution, high kinetics.

Intermediate: moderate temporal resolution, moderate kinetics.

Slow: slow temporal resolution, slow kinetics.

4 Check the value in the Contrast Arrival Time field. Adjust the
onset time of enhancement with the icon, if necessary.

5 Start pharmacokinetic modeling for mean ROI curves with the icon.

The fitting curve for the selected ROI label is displayed in the 4th
segment.

Calculated parameter values for the exchange of contrast agent
between blood and tissue are displayed top left in the diagram.

1 In the Selector list, select the VOI or the ROI whose parameters
should be fitted.

2 Start pharmacokinetic modeling for all voxels of the VOI or ROI
with the icon.

Fitting voxel by voxel
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Parameter maps describing the contrast media kinetics are
calculated for the selected VOI or ROI label. They are displayed as
color-coded overlays of the morphological images in the 3rd
segment.

Analyzing the results statistically
The parametric data of pharmacokinetic modeling are used to
calculate frequency distributions (histograms) and mean values for
the ROIs defined in the parameter images.

1 Open the 6. Results subtask card.

2 In the ROI Selection list, select an already existing ROI (e.g. ROI1).

3 Click the icon to copy the ROI from the 2nd segment to the
parameter image of the 3rd segment.

4 To define new ROIs, use the ROI drawing mode.

◆ Click the icon to calculate the frequency distribution of parameter
values inside the ROI.

Defining ROIs

Displaying a histogram
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The histogram is displayed in the 4th segment.

◆ Click the icon to calculate statistical data of parameter values inside
the ROI.

The median, mean and standard deviation for the selected ROI are
displayed bottom left in the 3rd segment.

Saving parametric data as ASCII files
1 Click the icon to save all parameter values from the 4th segment

for the selected ROI.

The values of the Ktrans, Kep, Ve, Chi2, FitCode, and iAUC
parameters are written to a text file.

2 Click the icon to save the currently displayed curves for the
selected ROI to a text file.

 You can open and post-process ASCII files, e.g. with Microsoft
Excel.

Displaying mean values

4.4.3
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Manufacturer’s note:

This device bears a CE mark in accordance with the
provisions of Council Directive 93/42/EEC of June 14, 1993
concerning medical devices and the Council Directive
2011/65/EU of June 08, 2011 on the restriction of the use
of certain hazardous substances in electrical and electronic
equipment.

The CE marking applies only to medical devices which have
been put on the market according to the above-mentioned
EC Directives. Unauthorized changes to this product are
not covered by the CE mark and the related Declaration of
Conformity.

Legal Manufacturer
Siemens Healthcare GmbH
Henkestr. 127
91052 Erlangen
Germany

Siemens Healthcare
Headquarters
Siemens Healthcare GmbH
Henkestr. 127
91052 Erlangen
Germany
Phone: +49 9131 84-0
siemens.com/healthcare
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